# Table of Contents

Table of Contents ......................................................... iii
Preface ................................................................. vii

- About this Manual ........................................ vii
- Documentation ............................................... vii
- Conventions Used in This Book ....................... vii
  - Terminology ........................................ vii
  - Special Characters and Fonts ................... viii
  - Special Paragraphs ............................... viii

**Installing ERDAS IMAGINE for Windows** .......................... 1

- Preparation for Installation ............................... 3
  - Introduction ....................................... 3
  - System Requirements .............................. 3
  - Installation Tips .................................. 5
  - ERDAS Software Security ......................... 5
    - License File ................................ 5
    - Hardware Key ................................ 5
    - License Tools ................................ 6
  - Installation ....................................... 6
    - Local Installation ............................. 6
    - Add-on Modules ................................. 6
    - Licensing ..................................... 6
  - The ERDAS IMAGINE CD-ROM ..................... 7

- Installing ERDAS IMAGINE ........................................... 9
  - Description ...................................... 9
  - Installing IMAGINE ................................ 9
  - Running IMAGINE in Demonstration Mode ....... 18
  - Licensing IMAGINE 9.1 ............................ 20

- Installing Geodatabase Support ....................... 21
  - Description ..................................... 21
  - IMAGINE Geodatabase Support .................. 21
  - Installing IMAGINE Geodatabase Support .... 22
Installing the Example Data ........................................ 29
  Description ..................................................... 29
  Installing Example Data ........................................ 29
    Installing Example Files from the Data DVD ................. 29

Uninstalling Leica Geosystems Software ......................... 35
  Introduction .................................................... 35
  Using the Install Manager ..................................... 35

Licensing ERDAS IMAGINE ........................................ 37
  Software Licensing ............................................. 39
    Description .................................................. 39
    SystemID ..................................................... 39
    Using Node Locked Licenses ................................ 41
      Installing a Node Locked License File .................... 41
      Merging New License Files ............................... 44
      Replacing a License File ................................. 45
    Using a Floating License Server ......................... 46

Configuring the License Server ................................ 51
  Description .................................................... 51
  Leica Geosystems Software Security ......................... 51
  Installing the License Server Tools ......................... 52
  Setting Up a License Server ................................ 57
    Licensing Leica Geosystems Software ...................... 57
    Adding a License File .................................... 58
    Merging a New License on the Server ..................... 60
    Replacing a License File on the Server ................. 61
    Start TCP/IP Services .................................... 61
    Customizing the License Servers ......................... 62

Configuring ERDAS IMAGINE ..................................... 63
  Windows Printing ............................................. 65
    Introduction ................................................ 65
    Troubleshooting ............................................ 66
      Out of Memory/Data Lost ................................ 66
      Nothing Prints ........................................... 66
      Preferences .............................................. 67
Spool RAW Data ........................................... 67
Scenarios ............................................... 68
  No Pre-Rasterize ................................. 68
  Pre-Rasterize ................................. 84

Adding Fonts to Annotation .................. 91
  Introduction .................................... 91
  Create an .fdb File ......................... 91
  Example .fdb Entries ....................... 93
  Font to Symbol Utility ..................... 94

Configuring IMAGINE VirtualGIS .......... 95
  Stereo Configuration for Windows Systems 95
  ERDAS IMAGINE Preference Settings ...... 95
  ERDAS IMAGINE Image Files (Native) .... 95

Index ................................................. 97
About this Manual

The ERDAS IMAGINE® Configuration Guide provides step-by-step instructions for installing ERDAS IMAGINE software, licenses, and configuring peripherals. Sections regarding viewer preferences and adding fonts to annotation are also included for your reference.

The sections about configuring peripherals tell you how to set up a tape drive and/or a tablet digitizer so that each can be accessed by ERDAS IMAGINE software. The sections are not intended to provide every detail about installing and configuring an input or output device. You should still refer to the manufacturer’s documentation for each device.

Documentation

This manual is part of a suite of on-line documentation that you receive with ERDAS IMAGINE software. There are two basic types of documents, digital hardcopy documents which are delivered as PDF files suitable for printing or on-line viewing, and On-Line Help Documentation, delivered as HTML files.

The PDF documents are found in <IMAGINE_HOME>\help\hardcopy. Many of these documents are available from the Leica Geosystems Start menu. The on-line help system is accessed by clicking on the Help button in a dialog or by selecting an item from a Help menu.

Conventions Used in This Book

In ERDAS IMAGINE, the names of menus, menu options, buttons, and other components of the interface are shown in bold type. For example:

“In the Raster dialog, select the **Fit to Frame** option.”

Raster is the name of a specific dialog and **Fit to Frame** is an option within that dialog.

Terminology

When asked to use the mouse, you are directed to click, shift-click, middle-click, right-click, hold, drag, etc.

- click — designates clicking with the left mouse button
- shift-click — designates holding the Shift key down on your keyboard and simultaneously clicking with the left mouse button
- middle-click — designates clicking with the middle mouse button
- right-click — designates clicking with the right mouse button
- hold — designates holding down the left (or right, as noted) mouse button
• drag — designates dragging the mouse while holding down the left mouse button

**Special Characters and Fonts**

Certain characters and font styles have special meaning in ERDAS IMAGINE documentation.

<words>

When you see words enclosed in < >, substitute the proper information for these words. For example, when you see <IMAGINE_HOME> in this document, replace it with the name of the drive and directory where ERDAS IMAGINE is installed on your system.

**Prompts**

Words that appear in the above font style represent program prompts that appear on the screen.

**Commands, Entries**

Words that appear in the above font style are used to show commands that you need to enter, and examples of data that you may enter as a response to a program prompt. A word enclosed in brackets [ ] at the end of a prompt is the default answer for that prompt. Press the Return key to accept the default answer.

**Special Paragraphs**

The following paragraphs are used throughout the ERDAS IMAGINE documentation:

- ![](ExclamationMark.png)

  *These paragraphs contain strong warnings or important tips.*

- ![Icon](Icon.png)

  *These paragraphs direct you to the ERDAS IMAGINE software function that accomplishes the described task.*

- ![Icon](Icon.png)

  *These paragraphs lead you to other sections of this manual or other specified manuals for additional information.*

- ![Icon](Icon.png)

  *These paragraphs draw your attention to useful information.*

**NOTE:** Notes give additional instruction.

**Shaded Boxes**

Shaded boxes contain supplemental information that is not required to execute the steps of a tour guide, but is noteworthy. Generally, this is technical information.
Installing ERDAS IMAGINE for Windows
Preparation for Installation

Introduction

This document provides updates to installation and configuration instructions for ERDAS IMAGINE V9.1 for Windows 2000, and Windows XP Professional.

NOTE: This manual contains important updated information that is crucial to the successful installation and operation of your software. Please read this manual before trying to install or run ERDAS IMAGINE.

It is strongly recommended that you have full administrator privileges to install ERDAS IMAGINE on a Windows operating system.

System Requirements

As with any advanced software, greater system resources result in greater performance. The following tables detail the minimum system requirements to run ERDAS IMAGINE V9.1.

<table>
<thead>
<tr>
<th>Computer/Processor</th>
<th>Intel Pentium 4 or higher, or any 100% compatible computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>1 GB or higher strongly recommended</td>
</tr>
<tr>
<td>Disk Space</td>
<td>4.5 GB (includes ERDAS IMAGINE 9.1, Geodatabase Support, IMAGINE Example Data, and Global Elevation Data)</td>
</tr>
<tr>
<td>Media Reader</td>
<td>CD-ROM drive for IMAGINE installation</td>
</tr>
<tr>
<td></td>
<td>DVD-ROM drive for Example Data installation</td>
</tr>
<tr>
<td>Display</td>
<td>Super VGA 1024 X 768 X 32 or higher</td>
</tr>
<tr>
<td></td>
<td>DirectX 9 or higher</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows XP Professional SP2 or higher</td>
</tr>
<tr>
<td></td>
<td>Windows 2000 Professional SP4 or higher</td>
</tr>
<tr>
<td></td>
<td>Windows Sever 2003 SP1 or higher (only supported for License Manager)</td>
</tr>
<tr>
<td></td>
<td>Windows XP Professional x64 Edition SP1 or higher (requires Intel EM64T or AMD64 processor)</td>
</tr>
</tbody>
</table>
**Software**
- OpenGL 1.1 or higher (for IMAGINE VirtualGIS® and Image Drape utility)*
- Adobe Acrobat Reader 5.0 or higher (for online documentation)
- Microsoft Developer Visual Studio .NET 2003 (required for IMAGINE Developers’ Toolkit)
- Internet Explorer 6 or higher using Java 1.4 or higher runtime

**Display Devices**
The ERDAS IMAGINE drape utility, IMAGINE VirtualGIS and Leica Stereo Analyst™ require OpenGL. Microsoft Windows provides a generic OpenGL driver for supported graphics cards. However, an OpenGL optimized graphics card and driver are recommended for these applications.

**Peripherals**
- One Microsoft Windows compatible mouse (Intellimouse recommended)
- Software security requires one of the following:
  - Ethernet card with TCP/IP configured (if not using hardware key), or
  - One Centronics parallel port, or
  - One USB port

**Hardcopy Devices**
Microsoft Windows supported hardcopy devices. **

**ArcGIS Interoperability**
ERDAS IMAGINE 9.1 can be installed on the same computers as ArcGIS versions 8.3, 9.0, 9.1 or 9.2 Pre-release and will not cause conflicts with these versions. ArcGIS 9.2 had not been released at the time of releasing ERDAS IMAGINE 9.1 and consequently it cannot be guaranteed to work, but testing with the Pre-release indicates good potential. Please refer to the LPS System Specifications for limitations which might occur between installations of LPS 9.1 and ArcGIS.

**Geodatabase Support**
There are two methods for providing Geodatabase support in ERDAS IMAGINE 9.1.

Both will only provide support to geodatabases of version 9.1 or earlier.

ESRI
Geodatabases versioned 9.2 cannot be read at this time.

- Install (and license) a copy of ArcGIS (V9.0 or 9.1 only), or
- Install the IMAGINE Geodatabase Support CD (requires no additional licensing of ArcGIS)

**Disk Space**
Several processes in ERDAS IMAGINE create temporary files. On a system with multiple disk drives, the drive that contains the default directory (c:\temp) may not have enough space. Be sure to set the **Temporary File Directory** in the **User Interface and Session** category of the **Preference Editor** to a directory with sufficient disk space (the actual amount you need depends on the size of the files and applications you use with ERDAS IMAGINE).

Some temporary files may not be deleted automatically, causing the temporary directory to become overloaded. If this happens, exit ERDAS IMAGINE and delete the files in the temporary directory.
If the Temporary File Directory in the Preference Editor specifies a nondirectory file or a nonexistent directory, no error message is reported and the c:\temp directory is created and used for temporary files.

Refer to the "Microsoft Windows System Guide" for information on configuring spool directories.

**Installation Tips**

The following is a list of general tips for proper installation of IMAGINE.

- To properly install ERDAS IMAGINE on a Windows operating system, it is strongly recommended that you have full administrator privileges.

- The Administrator must create a user account for each user. This gives each user a username and password for logging into the system. A unique home directory for each user is highly recommended in order to make use of ERDAS IMAGINE’s user-specific preference capabilities.

- The first time you run a new installation of ERDAS IMAGINE on a Windows operating system, you must be logged in as a user with full administrative privileges.

Refer to the "Microsoft Windows System Guide" for information on setting up user accounts.

**ERDAS Software Security**

This section gives you an overview of the ERDAS IMAGINE software security system.

**License File**

For each unique ID, there is a license file provided by Leica Geosystems. This file protects the software against unauthorized use and determines which modules you can use, the number of users, and when, or if, the modules expire. If the license file generated for a unique ID specifies multiple users, then the License Manager can be used to “float” licenses around a network.

**Hardware Key**

Although ERDAS IMAGINE V9.1 does not require the use of a hardware key, it can use the hardware key provided with previous installations of IMAGINE to provide a unique System ID number. The hardware key is a device that attaches to a parallel port on the computer. It is installed between the computer and any other peripheral device which may be connected to that port. It does not interfere with the normal use of the parallel port.
License Tools

In the case of a remotely licensed installation of ERDAS IMAGINE, the License Server acts as a license server by allowing multiple licenses to be “floated” from a single computer.

See "Software Licensing” on page 39 for an explanation of license serving functionality.

In addition to the License Server, there are some advanced licensing tools supplied by FLEXlm.

For more information on the FLEXlm tools, see the FLEXlm End Users Guide provided in the <IMAGINE_HOME>/help/hardcopy/enduser.pdf document.

Installation

The ERDAS IMAGINE installation process may include add-on modules. Running any of these add-on modules requires purchasing a license for them.

Local Installation

A local installation copies all necessary files and configures a machine to run ERDAS IMAGINE independently. It copies executable files to disk. All of the ERDAS IMAGINE modules and components reside only on the designated machine; network access is not required.

Add-on Modules

You can also incorporate add-on modules into an existing installation of ERDAS IMAGINE software.

In some cases, the module is included in the list of module components you access during installation. For example, you can choose VirtualGIS™ from the components list. If you have selected the add-on module during installation of ERDAS IMAGINE, then you can also incorporate its license file as you do the license file for ERDAS IMAGINE.

If you did not choose the module at the time of ERDAS IMAGINE installation, you can reinsert the CD into the CD-ROM drive and begin again. This time, select only the module you wish to install. You can also enter the license file separately.

Other add-on modules to ERDAS IMAGINE may come on separate CD-ROMs. In this case, simply insert the CD-ROM into the appropriate drive, and follow the installation instructions provided with the module. You can add the new license file at the end of the installation process.

Licensing

For any installation, the licensing can be local or remote (via the License Server). The remote option requires a network connection.
The ERDAS IMAGINE CD-ROM

The ERDAS IMAGINE CD-ROM master panel provides access to different components of ERDAS IMAGINE. Following is a description of what each one of the options does.

**Install Products** allows you to install ERDAS IMAGINE 9.1 or read the Release Notes for IMAGINE and the add-on modules.

**Visit Our Website** will open an internet browser and take you to http://www.gi.leica-geosystems.com

**Browse CD Contents** will display the file on the current CD in a Windows Explorer.

**Contact Us** displays the contact information which enables you to get in touch with Leica Geosystems.

**Exit** will close the CD-ROM master panel.
Installing ERDAS IMAGINE

Description

This section contains the steps for completing a local installation of ERDAS IMAGINE 9.1 software on a Windows 2000 or Windows XP Professional system. The dialogs used in the setup look the same regardless of system.

A local installation is one in which the ERDAS IMAGINE program files are run from the machine on which they are installed.

⚠️ It is strongly recommended that you have full administrator privileges to install ERDAS IMAGINE on a Windows operating system.

If you attempt to install ERDAS IMAGINE on a Windows 2000 or a Windows XP Professional system without Administrator privileges, a dialog opens instructing you that you are not able to install the software with the current privileges. Log out, log back in as a user with administrative privileges and then install IMAGINE.

Installing IMAGINE

Follow these instructions to install ERDAS IMAGINE.

1. Start Microsoft Windows.
   ⚠️ You should close all running applications before installing ERDAS IMAGINE.

2. Log in as a user with full administrative privileges.
   ⚠️ You must be logged in as a user with full administrative privileges to successfully install ERDAS IMAGINE.

3. Insert the ERDAS IMAGINE installation CD into the CD-ROM drive. The ERDAS IMAGINE CD-ROM master panel opens automatically.
NOTE: If your preference settings deactivate the autorun, you can also access this panel by selecting Start -> Run from the Microsoft application bar and entering `<CD-ROM>:\Launch` in the text box (where `<CD-ROM>` represents the drive letter of your CD-ROM drive).

4. Click Install Products from the ERDAS IMAGINE CD-ROM Master Panel.

The Product Selection Panel is displayed.
5. From the Product Selection panel, click on the **ERDAS IMAGINE 9.1** to Open the IMAGINE 9.1 panel.

6. Click ERDAS IMAGINE 9.1 to launch the Setup Wizard.
Installing ERDAS IMAGINE 9.1 does not install the Example data used in the Tour Guides. To install the Example Data, you must run the separate Example Data installer after you have installed IMAGINE.

The ERDAS IMAGINE CD-ROM master panel remains active in the background and the ERDAS IMAGINE V9.1 Setup window opens.

**Installing IMAGINE**

The Welcome dialog opens.

![Welcome dialog](image)

**NOTE:** If, at any time, you wish to terminate the ERDAS IMAGINE Setup, click on the **Cancel** button located at the bottom of the dialogs, select **Yes**, and then click the **Exit** button located on the ERDAS IMAGINE CD-ROM master panel.

1. Click **Next** in the Welcome dialog.
The License Agreement dialog opens. Please read the license agreement in its entirety. You can use the arrows or Page Down to view all of the LGGI Software License and Limited Warranty Agreement.

2. If you agree to the terms and conditions set forth in the Leica Geosystems Geospatial Imaging, LLC Software License Agreement, select the **I accept the terms in the license agreement** radio button. If not, select the I do not accept the terms in the license agreement radio button and click **Cancel** to exit the installation program.

3. If you accept the terms in the License Agreement, click **Next** in the License Agreement dialog.

The Destination Folder dialog opens. This dialog allows you to specify the name of the directory in which the IMAGINE files will be installed. All files required to run ERDAS IMAGINE are installed in this directory.
4. If you would like to change the installation directory, click the **Change...** button to access the Change Current Destination Folder dialog.

![Select directory here...](image)

...or enter the directory name here.

If you would like to create a new directory in which to install ERDAS IMAGINE, type the path in the text box or click the New Directory button.

5. Click to select or type the directory in which you would like to install **ERDAS IMAGINE**.

6. Click the **OK** button to return to the Destination Folder dialog.

7. Click the **Next** button at the bottom of the Destination Folder dialog. The Select Features dialog opens. This dialog enables you to select the ERDAS IMAGINE modules you want to install.
NOTE: For an explanation of the icons and their meanings, click the Help button.

8. Click to select the ERDAS IMAGINE modules you want to install.

For example, if you have purchased ERDAS IMAGINE Professional and Vector modules, and this is a new installation, you need to select at least the Essentials, Advantage, Professional, Radar Interpreter, and Vector modules.

The following table is provided to assist you when selecting modules to install.

<table>
<thead>
<tr>
<th>To Install These Modules...</th>
<th>Essentials</th>
<th>Advantage</th>
<th>Professional</th>
<th>AutoSync</th>
<th>OrthoRadar</th>
<th>Radar Interpreter</th>
<th>ISAR DEM</th>
<th>IMAGINE</th>
<th>Vector</th>
<th>VirtualGIS</th>
<th>Stereo Analyst</th>
<th>NITF 2.1</th>
<th>Online Help</th>
<th>Vector Feature Loader for Oracle</th>
<th>IMAGINE Enterprise Editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Essentials†</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Advantage</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Professional</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AutoSync</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OrthoRadar™</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Radar Interpreter‡</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Installing IMAGINE / 15
<table>
<thead>
<tr>
<th>To Install These Modules...</th>
<th>Essentials</th>
<th>Advantage</th>
<th>Professional</th>
<th>AutoSync</th>
<th>OrthoRadar</th>
<th>Radar Interpreter</th>
<th>StereoSAR DEM</th>
<th>IFSAR DEM</th>
<th>IMAGIZER Data Prep</th>
<th>Vector</th>
<th>VirtualGIS</th>
<th>Stereo Analyst</th>
<th>NITF 2.1</th>
<th>Online Help</th>
<th>Vector Feature Loader for Oracle</th>
<th>Georaster Loader for Oracle</th>
<th>IMAGINE Enterprise Editor</th>
</tr>
</thead>
<tbody>
<tr>
<td>StereoSAR DEM™</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>IFSAR DEM™</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>IMAGIZER Data Prep</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Vector</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>VirtualGIS</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Stereo Analyst</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>NITF 2.1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Online Help</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Vector Feature Loader for Oracle</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Georaster Loader for Oracle</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>IMAGINE Enterprise Editor</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>✓</td>
</tr>
</tbody>
</table>

†IMAGINE Essentials includes the MrSID encoder that utilizes the MrSID compression technology patented by LizardTech.
‡The Radar Interpreter may be installed as an add-on module or as part of IMAGINE Professional. Either way, it must be selected explicitly.

9. Click the **Next** button at the bottom of the Select Features dialog.
The Ready to Install the Program dialog opens.

10. Click the **Install** button at the bottom of the Ready to Install the Program dialog to begin the actual installation.

A status bar displays, tracking the progress of the installation:

When the status bar reaches 100%, the Registering Components dialog is displayed.
When the Registration is finished, the **Installation Complete** dialog is displayed.

![Installation Complete dialog]

11. To specify the license file or license server, check the **Launch License Manager** check box.

   *Raster formats, vector formats, geometric models, resample methods, and the help index can only be configured by a user with Administrative privileges. If you deselect this checkbox, IMAGINE will configure all of the formats and indices the first time you run IMAGINE.*

12. Click **Finish** in the Installation Complete dialog.

   The Leica Geosystems Geospatial Imaging License Manager will display after the Installation process finishes. The License Manager allows you to license your installation of ERDAS IMAGINE.

   *For information on using the License Manager and on setting up a license server, see "Software Licensing" on page 15.*

---

**Running IMAGINE in Demonstration Mode**

ERDAS IMAGINE will allow you to evaluate the software for thirty days before you are required to purchase a license. Follow these steps to run ERDAS IMAGINE in the Demonstration mode.

*You must have Administrative privileges to run IMAGINE in the Demonstration Mode.*

*If you have already run a previous version of IMAGINE in Demonstration mode, you cannot run the new version of IMAGINE in Demonstration Mode.*

Running IMAGINE in Demonstration Mode
1. To start ERDAS IMAGINE, use the Microsoft task bar to select Start / All Programs / Leica Geosystems / Geospatial Imaging / ERDAS IMAGINE 9.1 / ERDAS IMAGINE 9.1 from the menu. This runs the eml.exe program in <IMAGINE_HOME>\Bin\NTx86. As an alternate, a shortcut can also be made to ERDAS IMAGINE and placed on the desktop. When you run IMAGINE in Demonstration Mode, the Welcome to ERDAS IMAGINE dialog opens.

![Welcome to ERDAS IMAGINE](image)

This dialog will allow you to use the software in the 30-day demonstration mode, to license the software by specifying a license file, to license the software by identifying the computer serving floating licenses or to request a license from the ERDAS Licensing web page.

2. Select Run ERDAS IMAGINE in Demonstration Mode and click Continue. The ERDAS IMAGINE in Demonstration Mode dialog displays.

![ERDAS IMAGINE Demonstration Mode](image)

This dialog gives you information about your demonstration license, including the date it expires. Click OK to Continue.
The ERDAS IMAGINE Demonstration Mode will continue to work for 30 days after it is first started. After the 30 day Demonstration period has passed, the ERDAS IMAGINE Demonstration Mode dialog appears without the continue button. This dialog allows you to locate the license file, to specify the location of the license server or to request a license file from the ERDAS web site.

See "Software Licensing" on page 15 for further details.

**Licensing IMAGINE 9.1**

IMAGINE 9.1 uses a form of licensing called FLEXlm. This program will use a license file to secure all modules.

*For information on Licensing IMAGINE and other Leica Geosystems software products, see "Software Licensing" on page 15.*
Installing Geodatabase Support

**Description**

This section contains the steps for installing support for ArcGIS Geodatabases in ERDAS IMAGINE. With IMAGINE, you will have common access to ArcGIS vector data sources.

*If you have ArcGIS, ArcMap, ArcCatalog installed on your system, there is no need to install Geodatabase Support. IMAGINE will automatically interact with ArcGIS.*

**IMAGINE Geodatabase Support**

ERDAS IMAGINE introduces the use of ESRI’s ArcObjects environment to better interact with the latest generation of ArcGIS software and data formats. The use of ArcObjects means that ERDAS IMAGINE is better able to act as an “extension” to ArcGIS, providing advanced image processing and remote sensing capabilities, while transparently interacting with ESRI’s new data formats, such as the Geodatabase.

The following is a list of the types of read-only operations which exist within ERDAS IMAGINE and which therefore can now be applied to the data sources accessed in the Geodatabase.

- Display vectors on top of an image
- Include vectors in a map composition
- Display attributes associated with vectors in a table or the new Form View
- Apply attribute-based symbolization to features
- Use features (points, lines, polygons) in supervised classification
- Use features in Spatial Models
- Use features in the Surfacing Tool
- Use features to define Areas of Interest (AOIs) to geographically constrain any type of process that supports AOIs.

The following list of types of edits would only apply to the Personal Geodatabase.

- Edit features (if the feature source is editable)
- Edit attributes (if the feature source is editable)
- Add/Create columns (if the feature source supports this)
Follow these instructions to install IMAGINE Geodatabase Support.

⚠️ It is strongly recommended that you have full administrator privileges to install ERDAS IMAGINE on a Windows operating system.

If you attempt to install Geodatabase Support on a Windows system without Administrator privileges, a dialog opens instructing you that you are not able to install the software with the current privileges. Log out, log back in as a user with administrative privileges and then install Geodatabase Support.

1. Start Microsoft Windows.

⚠️ It is strongly recommended that you close all running applications before installing ERDAS IMAGINE Geodatabase Support.

2. Log in as a user with full administrative privileges.

⚠️ You must be logged in as a user with full administrative privileges to successfully install ERDAS IMAGINE Geodatabase Support.

3. Insert the ERDAS IMAGINE Geodatabase Support installation CD into the CD-ROM drive.

The IMAGINE Geodatabase Support Setup master panel opens automatically.
NOTE: If your preference settings deactivate the autorun, you can also access this panel by selecting Start | Run from the Microsoft application bar and entering <CD-ROM>:\Launch in the text box (where <CD-ROM> represents the drive letter of your CD-ROM drive).

4. From the Geodatabase Support for ERDAS IMAGINE CD-ROM master panel, click on the Install Geodatabase button to launch the setup options.

The Geodatabase Support for ERDAS IMAGINE CD-ROM master panel remains active in the background and the ERDAS IMAGINE Geodatabase Support Setup window opens and fills the screen.

If you already have any of the ESRI ArcGIS products installed on your system, the following message is displayed, telling you that Geodatabase Support does not need be installed on a system with any of these products.

5. Click OK to exit the installation.
The Welcome dialog opens.

![Welcome dialog]

It is strongly recommended that you close all running programs before you install Geodatabase support.

**NOTE:** If, at any time, you wish to terminate the ERDAS IMAGINE Geodatabase Support Setup, click on the **Cancel** button located at the bottom of the dialogs, select **Exit Setup**, and then click the **Exit** button located on the ERDAS IMAGINE Geodatabase Support CD-ROM master panel.

6. Click **Next** in the Welcome dialog.
The License Agreement dialog opens. You can use the arrows or Page Down to view all of the ERDAS Software License and Limited Warranty Agreement.

7. If you agree to the terms and conditions set forth in the ERDAS Software License and Limited Warranty Agreement, select the appropriate radio button and click **Next** (if not, click **Cancel** to abort the installation).

The Begin Installation dialog displays

8. Click **Install** to begin the installation of Geodatabase Support for ERDAS IMAGINE.

   Do not remove the IMAGINE Geodatabase Support CD-ROM from the drive while performing the installation.
The Updating Windows Installer dialog displays.

The ArcGIS9.1 Geodatabase Support dialog is displayed.

The ArcView Setup dialog is then displayed and the progress bar shows the status of the installer.
When the installation is complete, the Finished dialog will open.

9. Click **Finish** to close the installation program.
Installing the Example Data

Description

This section contains the steps necessary for installing the ERDAS IMAGINE and LPS Example Data on a Windows 2000 or Windows XP Professional system. The dialogs used in the setup look the same regardless of system.

The Example data are used to complete the ERDAS IMAGINE and the LPS Tour Guides.

Installing Example Data

The Example data used in the Tour Guides is included on two separate DVD-ROMs labeled IMAGINE and LPS Example Data Disk 1 and IMAGINE and LPS Example Data Disk 2.

⚠️ Installing ERDAS IMAGINE and LPS will not automatically install the example data used in the Tour Guides. To install the Example Data, you must run the separate Example Data installer.

Installing Example Files from the Data DVD

1. Insert the ERDAS IMAGINE & LPS Example Data DVD into the DVD-ROM drive.

The master panel opens automatically.
NOTE: If your preference settings deactivate the autorun, you can also access this panel by selecting Start -> Run from the Microsoft application bar and entering <DVD-ROM>:\Launch in the text box (where <DVD-ROM> represents the drive letter of your DVD-ROM drive).

2. From the ERDAS IMAGINE & LPS Example Data master panel, click on Install Example Data to launch the setup options.
NOTE: If, at any time, you wish to terminate the Example Data Setup, click on the **Cancel** button located at the bottom of the dialogs, select **Yes**, select Finish in the Installshield Wizard, and then click the **Exit** button located on the ERDAS IMAGINE Example Data DVD-ROM master panel.

3. Click **Next** in the Welcome dialog.

The License Agreement dialog opens. You can use the arrows or Page Down to view all of the Leica Geosystems Geospatial Imaging, LLC Software License and Limited Warranty Agreement.
4. If you agree to the terms and conditions set forth in the Leica Geosystems Geospatial Imaging, LLC Software License and Limited Warranty Agreement, select the appropriate radio button and click **Next** (if not, click **Cancel** to abort the installation).

The Custom Setup dialog opens. This dialog is where you to select which example data sets you want to install.

For an explanation of the icons and their meanings, click the **Help** button.

5. Click to select the example data you want to install (by default they are all selected for you).

6. Click the **Next** button at the bottom of the Custom Setup dialog.

7. If there is not enough space on the selected drive to install the example data, the Out of disk Space dialog displays, so you can choose a new location in which to install the data.
This dialog displays the available space on your system.

8. Click **OK** to close this dialog and return to the installation wizard.

   > The Example Data must be installed in the same directory as ERDAS IMAGINE and/or LPS.

   > If there is not enough space for all of these programs and the Example Data, you can select a subset of the Example Data to install from the select components dialog, or you can reinstall IMAGINE and LPS in a location that has sufficient space.

The Ready to Install dialog displays.

9. Click the **Install** button at the bottom of the Ready to Install dialog to begin installing the example data.

   A status bar displays, tracking the progress of the installation.
If needed, the installer will prompt you to insert the second Example Data disk:

10. Insert ERDAS IMAGINE and LPS Example Data Disk 2 and click OK. When the installer is finished, the Installation Complete dialog opens:

11. Click Finish to close the installer.
Uninstalling Leica Geosystems Software

**Introduction**

When uninstalling Leica Geosystems software, it is important to remember to uninstall all of the modules and fixes in the reverse order from how they were installed. This can be a confusing process, because you might not remember what that order was.

To help with the uninstallation process, you can now use the Leica Geosystems Install Manager. This program displays all of the Leica Geosystems software that is installed on your system, and the order in which each of the modules was installed.

**Using the Install Manager**

Start the Install Manager from the Start Menu.

1. Click **Start -> All Programs -> Leica Geosystems -> Install Manager**. The Install Manager is opened.

The Modules Installed list displays all of the Leica Geosystems modules that have been installed on your system.

The modules are sorted into independent groups. For example, the Leica Virtual Explorer module above is independent of the Geospatial Imaging modules and may be removed at any time.
2. Select a product or fix from the Modules Installed list. The selected module is described in the Module Description field.
   If the selected module was the last module installed in that group, the **Remove** button is enabled.

3. Click the **Remove** button to uninstall the selected module.

4. Continue removing modules until you have uninstalled the module that you wanted to remove.

5. If necessary, you may now reinstall any of the modules that were removed but that you would like to keep on your system.
Licensing ERDAS IMAGINE
**Software Licensing**

**Description**

Leica Geosystems software uses a form of licensing called FLEXlm. This program will use a license file to secure all modules.

---

For more information on using the FLEXlm Licensing Tools, see the FLEXlm End Users Guide file provided in `<Software_HOME>/help/hardcopy/enduser.pdf`.

---

You must have Administrative privileges to set or change the security settings on a Windows Operating System.

What you need to do before licensing your Software:

- Get your System ID number. See “SystemID”.
- List the modules for which you need licenses.
- Determine the number of licenses you need.
- Determine the type of license you need (that is, floating or node locked).
- If you are going to use floating licenses, install Leica Geosystems License Server on the server. See “Installing the License Server Tools” on page 28.

**SystemID**

The SystemID is the unique identification number used to identify your system. This number is needed to issue a license file to you.

To find your System ID, start the License Manager tool from the Windows Start menu. Select **Programs -> Leica Geosystems -> Licensing Tools -> License Management**.
The **System ID** text box gives an ID of your system from the selected System ID Source. This ID is a unique ID derived from components of your system.

The **Source** popup list indicates the source of the system ID. The software can obtain ID numbers from the following sources:

- CPU IDs
- Hard Disk Serial Numbers
- Hardware Keys
- Local Area Connection
- Network Cards (default)

You may change the System ID source by selecting an item from the Source popup list.

---

*We recommend that you select a System ID Source that will remain constant for as long as you will be using the software. For instance, you should not choose the network card associated with your laptop’s docking station if you want to use the software while the laptop is not docked.*
Removing the hardware used to obtain the System ID changes your System ID and will cause previous license files to be invalid. Contact Leica Geosystems to see about obtaining new license files.

The License Source names the computer that is running the LGGI License Server. If the computer has no license file, this field will be blank.

The Hardware Security Key Driver section of the SystemID tab will only appear active if you have a hardware key from a previous version of LGGI software installed on your system. The new Leica Geosystems software will install all new Sentinel drivers automatically. If the driver is not present, you may click the Install Driver button and follow the instructions.

Using Node Locked Licenses

Once you have identified your System ID, you can get a license file. You can request a license file online by visiting the Leica Geosystems licensing webpage at http://gi.leica-geosystems.com/Codewords/.

Customers outside of the USA should contact their local distributor for more information.

You will need to know the following information before you request your license file:

- The System ID number for the computer running the software.
- The modules for which you need licenses.

NOTE: Save the license file in an easily accessible location.

All node-locked license files will have the .lgl extension.

Installing a Node Locked License File

Once you have obtained your Node Locked license file keyed to the System ID for the machine on which the software is to be run, you can install it on the system.

Automatically Installing the License File

To install a license file, double-click on it in the Windows Explorer. The license file will be automatically loaded.

Manually Installing the License File

Advanced users may want to manually install the license file. Follow these steps to manually install the license file.
1. Start the License Manager tool from the Windows Start menu. Select Programs -> Leica Geosystems -> Licensing Tools -> License Management.

The License Manager dialog displays:

```
Click the Help button for on-line help about loading the license file.
```

2. Click the Add button in the License Source group.

The License Source Information dialog displays.

3. Select the **Node locked license** radio button to display the Node locked license setup options.
4. Click **Load** to add the Node Locked license file.

    You may also drag and drop the .lgl file into the text area.

5. Browse to the location in which you saved the license file (.lgl) and click **Open**.

6. The license file displays in the **Node locked license setup** window.

7. Click **OK**.

   The License Manager dialog displays. The new node-locked license source displays in the **License Source** field.
8. Click OK to dismiss the License Manager and begin using your Leica Geosystems software.

**Merging New License Files**

If you purchase new modules or multiple Leica Geosystems programs (such as ERDAS IMAGINE and Leica Photogrammetry Suite), you may receive multiple node locked license files. The new license files must be merged with the existing license files to run all of your software.

**Automatically Merging the License File**

To merge a license file, double-click on it in the Windows Explorer. The license file will be automatically merged with the previously loaded license file.

*To Replace an existing license file, see "Replacing a License File" on page 21.*

**Manually Merging the License File**

Advanced users may want to manually merge the license files. The steps for manually merging a license file are identical to the steps for "Installing a Node Locked License File" on page 17.

When you click OK to add your license file, it will automatically be merged with the existing file.
Checking for the New Modules
To check and ensure that your new license has been properly loaded, you can check the list of Licensed Modules for the upgraded modules.

1. From the Leica Geosystems Geospatial Imaging License Manager, select the Module Information tab.

2. Make sure that lggm_nodelocked_license_file.lgl is selected in the License Source popup list.

3. Scroll down and check to make sure your newly licensed software module and version is in the list of licensed modules.

Replacing a License File
It may be necessary to completely replace the license file. To replace the license for an expired module or install a completely new license file, first perform the following steps:

1. Start the License Manager tool from the Windows Start menu. Select Programs -> Leica Geosystems -> Licensing Tools -> License Management.

The License Manager dialog displays:

Click the Help button for on-line help about loading the license file.

2. Select the lggm_nodelocked_license_file.lgl by clicking on it in the License Source field.

The Modify and Remove buttons are activated.
3. Click **Remove**.
   A dialog opens asking if you would like to delete the license file from
   the hard disk.

4. If you would like to delete the license file from the disk, click **Yes**.
   Otherwise, click **No**.

5. Double-click on the new license file to install it in the License
   Manager.

6. Click **OK** to dismiss the Leica Geosystems Geospatial Imaging
   License Manager dialog.

   Your new license file has been installed and ERDAS IMAGINE is ready
   to run.

---

**Using a Floating License Server**

If you have already set up a License Server, you may add that server
   to the list of available licensing sources for this installation.

---

*You must configure the License Server and start the License
Service before attempting to use a floating license.*

---

*For instructions on configuring a license server, see “Setting Up
a License Server” on page 33.*

1. Log on to the machine running Leica Geosystems software as a user
   with Administrative privileges.

2. Click **Start -> Programs -> Leica Geosystems -> License Tools -> License Management.**
   The Leica Geosystems License Manager dialog opens.
Click the Help button for on-line help about specifying a license file server.

3. Click the Add button in the License Source group.
   The License Source Information dialog displays.

4. Select the License server information radio button to display the License Server setup options.
5. Enter the name of the computer that has been configured as the License Server in the **Server Name** field.

   *You may also click the **Browse** button to locate the license server.*

6. If the license server is running on a non-standard port, select the **Use Custom Port** checkbox and enter the port number.

7. Click **OK**.

**If There Is No License Server Found**

   If there is no license server configured on the chosen system, the following message displays.

8. Double-check the Server Name and port number.

9. If the Server name and port number are correct, click **Yes** to add the license server, and then make sure the license server on that machine was set up correctly and the license service has been started.
If the server name or port number was incorrect, click No, and enter the correct server name or Browse to the correct server.

10. Click OK on the License Source Information dialog.

**License Server Successfully Added**

If the License Server has been successfully added, the License Manager displays. The License Source field reflects the addition of the Floating License Server.

11. Click OK to close the License Manager and begin using your Leica Geosystems software.
Configuring the License Server

Description

This chapter explains the steps for preparing your Windows system to run the Leica Geosystems License Server. There are two main sections to this chapter, installing the License Server and Setting up the License Server.

The license tools are installed as part of every Leica Geosystems software package, such as ERDAS IMAGINE. If you have already installed Leica Geosystems Software, you can find instructions for configuring the License Server in “Setting Up a License Server” on page 33.

You only need to install the License Tools if the machine you are setting up to serve licenses over the network does not have Leica Geosystems software installed on it.

The system setup and the software installation should be performed by an Administrator who is familiar with the Windows system and its documentation.

⚠️ We strongly recommend that you have full administrator privileges to install the License Tools on a Windows operating system.

If you attempt to install the License Tools on a Windows system without Administrator privileges, a dialog opens instructing you that you are not able to install the software with the current privileges. Log out, log back in as a user with administrator privileges and then install the License Tools.

Leica Geosystems Software Security

When performing an installation with node-locked licensing, security is built-in and automatic. Each computer is individually secured with its own license file. If circumstances dictate, as in the case of an installation with remote licensing, you can secure all copies of the software from a single computer, called the License Server.

Leica Geosystems software security is optionally controlled through the use of the License Server program that is always running on at least one computer in the network. The License Server secures all copies of Leica Geosystems software that operate on the network. Each License Server must have a license file. You can request a license file from the Leica Geosystems Licensing web page at http://www.gi.leica-geosystems.com/Codewords/.
If you wish to use remote licensing, you must determine on which workstation(s) the security program, Leica Geosystems License Server, is going to reside before you begin installing software.

All Leica Geosystems programs communicate with the License Server using Transport Control Protocol/Internet Protocol (TCP/IP). TCP/IP must be configured on each machine that relies on the License Server for security.

See your Windows documentation or on-line help for more information on TCP/IP.

Two tasks must be performed prior to accessing a remote license server:

- Start TCP/IP services on all workstations relying on the remote license server for their licenses. For information on starting TCP/IP services, see "Start TCP/IP Services" on page 37.

- Start the License Server.

If you are installing the License Server software on a computer that is connected to a network with other computers running Leica Geosystems software, perform the procedures below.

For more information on using the FLEXlm Licensing Tools, see the FlexLM End Users Guide located in <Software_HOME>/help/hardcopy/enduser.pdf.

---

**Installing the License Server Tools**

Use these instructions to install the LGGI License Server on the computer connected to a network.

If you have installed LGGI software on this system, the Licensing Tools have already been installed. See "Setting Up a License Server" on page 33 to configure the License Server.

1. Start Microsoft Windows.

   You should close all running applications before installing ERDAS IMAGINE.

2. Log in as a user with full administrative privileges.
You must be logged in as a user with full administrative privileges to successfully install ERDAS IMAGINE.

3. Insert the ERDAS IMAGINE installation CD into the CD-ROM drive. The ERDAS IMAGINE CD-ROM master panel opens automatically.

NOTE: If your preference settings deactivate the autorun, you can also access this panel by selecting Start -> Run from the Microsoft application bar and entering <CD-ROM>:\Launch in the text box (where <CD-ROM> represents the drive letter of your CD-ROM drive).

4. Click Install Products from the ERDAS IMAGINE CD-ROM Master Panel.
   The Product Selection Panel is displayed.
5. From the Product Selection panel, click on the **ERDAS IMAGINE 9.1** to Open the IMAGINE 9.1 panel.

6. Click **Licensing Tools** to launch the Setup Wizard. The Welcome dialog opens.
NOTE: If, at any time, you wish to terminate the Leica Geosystems Geospatial Imaging Licensing Tools Setup, click on the Cancel button located at the bottom of the dialogs, select Exit Setup, and then click the Exit button located on the CD-ROM master panel.

7. Click Next in the Welcome dialog.
   The License Agreement dialog opens. You can use the arrows or Page Down to view all of the Leica Geosystems Geospatial Imaging, LLC Software License and Limited Warranty Agreement.
8. If you agree to the terms and conditions set forth in the Leica Geosystems Geospatial Imaging, LLC Software License Agreement, select the **I accept the terms in the license agreement** radio button. If not, select the I do not accept the terms in the license agreement and click **Cancel** to exit the installation program.

9. If you accept the terms in the License Agreement, click **Next** in the License Agreement dialog.

   The Ready to Install dialog opens.

![Image of Ready to Install dialog]

10. Click the **Install** button at the bottom of the Ready to Install dialog to begin the actual installation.

   A status bar displays, tracking the progress of the installation:

![Image of Installation in progress]

When the status bar reaches 100%, the **Installation Complete** dialog displays.
11. Click **Finish** to close the Installation Wizard.

**Setting Up a License Server**

Now that you have installed the Leica Geosystems License Server, you are ready to load your floating licenses.

---

**By the way**

*Before you load a new license file or change an existing license file, you must make sure that the license service has been stopped.*

---

**Licensing Leica Geosystems Software**

Once the License tools are installed, you need to obtain a floating license file. You may request a license file from the Leica Geosystems web page at: [http://gi.leica-geosystems.com/Codewords/](http://gi.leica-geosystems.com/Codewords/).

You will need to know the following information before you request your license file:

- The System ID number for the computer running the Install License Server.
- The name of the computer on which the License Server program was installed.
- The modules for which you need licenses.
- The number of licenses you need for each module.

**NOTE:** *Save the license file in an easily accessible location.*

---

*All floating license files will have the .lgs extension.*
Adding a License File

Stopping the License Service


2. If the License server status in the Configure Server group is Running, click Stop.

Automatically Installing the License File
To automatically install a license file, double-click on it in the Windows Explorer. The license file is loaded automatically.

Manually Installing the License File
Advanced users may want to manually install the license file. Follow these steps to manually install the license file.

⚠️ In order to properly run the Install License Server setup, you must have administrative privileges.

Before you load a new license file or change an existing license file, you must make sure that the license service has been stopped.

2. Click on the Load button. The Open file dialog opens and lets you browse to the License file location.

You can also drag and drop the license file into the License File area.

3. Select the license file and click Open to dismiss the dialog.
   The contents of the License file are loaded into the License Server Setup Tool.

4. Make sure that the Create Windows 2000/XP Service button is selected.

5. Select the Start license server automatically after reboot checkbox to have the license server autostart every time the Operating System is rebooted.

6. Click OK to dismiss the Leica Geosystems License Server Tools dialog.
The following dialog displays:

7. To begin serving licenses over the network, click **Yes**. If you have additional licenses to add, click **No** and proceed to “Merging a New License on the Server”.

**Merging a New License on the Server**

If you are going to license several different Leica Geosystems software products from the same license server, or if you received more than one license file to serve you will need to merge the additional licenses on the license server.

**Automatically Merging the License File**

To automatically merge a license file, double-click on it in the Windows Explorer. The license file will be automatically merged with the existing file.

**Manually Merging the License File**

Advanced users may want to manually merge the license file. Follow these steps to manually merge the new license file with the existing license file.

> It is highly recommended that you **Backup** your old license file before proceeding.

1. Perform the steps in “Manually Installing the License File” on page 34.

2. In the following message box, click **Yes** to merge the license files.

![License Server Setup Tool](image)

Note that the license field changes to show the information in your new license.

3. Click the **Start** button to start the license server.

4. Click **OK** to dismiss the Leica Geosystems License Server Setup Tool. Your new license file has been installed and your software is ready to run.
Replacing a License File on the Server

It may be necessary to completely replace the license file. To replace the license for an expired module or install a completely new license file, perform the following steps:

2. Click the Clear All... button.
3. Click Yes to clear the contents of the License File field.
4. Perform the steps for “Adding a License File” on page 34.

Start TCP/IP Services

Every computer that will be using the License Server to license Leica Geosystems software must have the TCP/IP services properly configured.

Windows 2000

1. Select Start -> Settings -> Control Panel from the Microsoft task bar.
2. Double-click the Network and Dial-up Connections icon.
3. Right-click the Local Area Connection icon and select Properties from the context menu.
4. Click the Protocols tab in the Network dialog.
5. If Internet Protocol (TCP/IP) is not included in the list, click the Install button.
6. Select Protocol and click the Add button. The Select Network Protocol dialog is opened.
7. Select Internet Protocol (TCP/IP) from the list of Network Protocols and click OK.
   The hostname and the IP address of each computer which will be using the License Server to license Leica Geosystems software must be listed in your hosts file or be accessible through a Domain Name Server (DNS). To edit the hosts file, use Notepad to open (or create) the directory called `<WindowsDir>\system32\drivers\etc\hosts` for Windows 2000.

Windows XP

1. Select Start -> Settings -> Control Panel from the Microsoft task bar.
2. Click Network and Internet Connections.
3. Click Network Connections.
4. Right-click the Local Area Connection icon and select **Properties** from the context menu.

5. If **Internet Protocol (TCP/IP)** is not included in the list, click the **Install** button.

6. Select **Protocol** and click the **Add** button. The Select Network Protocol dialog is opened.

7. Select **Internet Protocol (TCP/IP)** from the list of Network Protocols and click **OK**.

   The hostname and the IP address of each computer which will be using the License Server to license Leica Geosystems software must be listed in your hosts file or be accessible through a Domain Name Server (DNS). To edit the hosts file, use Notepad to open (or create) the directory called `<WindowsDir>\system32\drivers\etc\hosts`

---

**Customizing the License Servers**

The FLEXlm Licensing software will allow you to customize to the License Servers. To accomplish this, use the Tools in **Start -> Programs -> Leica Geosystems -> License Tools -> FLEXlm Tools**.

---

*For more information on using the FLEXlm Licensing Tools, see the FlexLM End Users Guide located in `<IMAGINE_HOME>/help/hardcopy/enduser.pdf`.**
Configuring ERDAS IMAGINE
Windows Printing

Introduction

This chapter provides information about how to set up your map composition for printing.

The above map composition is used in the following example. The map composition measures 48” × 68”.

NOTE: This map composition is not included in the <$IMAGINE_HOME>/examples directory.

This document is based on the premise that the printing to be done can be executed on an HP plotter using an HPRTL print driver on Windows 2000 or Windows XP Professional.
Troubleshooting

Sometimes when you are trying to print a map, system resources are consumed by the printing process, and the attempt to plot fails. There are several ways in which a printing failure might manifest itself. Depending on the type of print device being used, the indications of failure vary. The most common, of course, is that you do not successfully print the desired map. The symptoms of failure shown below are common for HP 600 to 3500 plotters. This includes the 1055 series.

Out of Memory/Data Lost

This is a printer panel message that is displayed when the printing application overwhelms the printer memory with data. This commonly occurs when postscript print drivers are used to attempt a print job that sends more data to the print device than the print device has memory to handle.

In ERDAS IMAGINE, this situation can also occur if you do not choose to Rasterize before printing. In the case where you do not choose to Rasterize before printing, the map composition should be processed using the In computer memory option. Commonly, when the system runs out of memory, the composition is partially printed. It is not unusual that whole elements of the map composition might be missing.

Nothing Prints

In another example, you send your map composition to print, and the process initiates successfully. However, as soon as the print job switches from spooling to printing, the job is deleted from the queue. There are no results to speak of. The only potential error message is from the OS: Your system is running low on virtual memory. Please close some applications. This is dependent on your system’s virtual memory settings.

It is advisable that you increase the default Windows virtual memory settings. On Microsoft Windows systems, there are initial and maximum size settings for the virtual memory that are made available to applications. The default minimum memory is acceptable, but the overall may need to be increased.

Changing Memory Settings

Increasing overall memory can be accomplished by:

- increasing the maximum on the existing paging file.
- creating an additional paging file (if there is not sufficient free disk space on the drive or partition where the other paging has been created).

It is also common that, when the Commit Charge value on the Windows Task Manager exceeds ~ 1 GB, nothing prints. Eventually, this occurs when processing without Rasterize before printing and In computer memory.
Preferences

Strip Height

The Strip Height is set to 64 by default. This is an acceptable strip height. This is the height of each strip of data that is sent to the plotter.

Printing Data Transfer Compression

Printing Scale Factor is the scaling factor at which the output data is created. This scale applies to the output frame size. For example:

- none = 1x
- low = 2x
- medium = 4x
- high = 8x

For example, if the image that is being put into a frame is 5000 × 6000 pixels, and the frame in which the image data is going to be printed is 17” × 20”, and you are plotting at 600 dpi, then there are 5000 pixels with which to fill 10200 dots.

Scaling is always constrained to the smaller of the dimensions to maintain geometric fidelity. In the example above, a scaling factor of 2 would be appropriate. If a scaling factor of one were used, ERDAS IMAGINE would create a file big enough to fill the output map frame. This is, in essence, quadrupling the size of the raster data needed to be sent to the plotter.

Moreover, a scale factor of two is a good trade-off in that little annotation degradation occurs. If the Printing Scale Factor is too high, text annotation can become pixelated.

Spool RAW Data

In order to print successfully in ERDAS IMAGINE, data must be spooled to the printer as the RAW datatype. These steps show you how to set your printer driver to always spool the RAW datatype.

1. From the Windows Start button, click Settings -> Printers to display the Windows Printers dialog:

   ![Printers dialog]

2. Right-click on the icon for the desired printer, and click Properties to display the Printer Properties dialog:
Scenarios / 68

3. From the **General** tab, click on the **Print Processor** button to open the Print Processor dialog:

4. Check the **Always spool RAW datatype** checkbox.

**Scenarios**

**No Pre-Rasterize**

You may encounter the following scenarios when printing:

These steps work for a moderate size map composition (e.g., 24” x 36” at 600 dpi). The no pre-rasterize scenario does not create a temporary file: all processing is handled in memory. This scenario can lead to the situation where nothing prints when the limits of system memory are exceeded. Any time the Commit Charge exceeds 1 GB, the print job is removed from the queue.

**Preparation**

ERDAS IMAGINE must be running.
You must have a map composition displayed.

*NOTE: The map composition displayed in this scenario is not supplied with the examples data.*

The following picture shows a Map Composition ready to print:

![Map Composition Ready to Print](image)

**Open the Map Composition Dialog**

1. In the Map Composer dialog, click the Print icon \[ \].

   This brings up the Print Map Composition dialog. The Print Map Composition dialog opens on the **Printer** tab. In this tab, you can select a printer you have configured.

   *For information about how to configure a printer, see the most recent ERDAS IMAGINE Installation Guide.*
2. Click the **Print Destination** dropdown list and choose an appropriate printer.

   **NOTE:** If you do not have any printers configured on your computer, then the only options that appear are *Image File* and *EPS File*.

   The **Print Destination** you select displays in the Print Map Composition dialog. Now, you can set configuration parameters.
3. Click on the **Change printer configuration** button. The Properties dialog for the printer you select displays. In this case, the title of the dialog is HP DesignJet 2500CP by HP.

4. Click on the **More sizes** button. The Paper Sizes dialog opens. In this dialog, you can set the paper size required for your particular map composition.
5. Click in the **Custom paper size** section of the Paper Sizes dialog and type the size of the paper. In this case, the appropriate size is 36” × 26”.

6. Click **OK** in the Paper Sizes dialog.  
   You are returned to the **Paper Size** tab of the Properties dialog.

7. In the **Paper Size** tab of the Properties dialog, click the **Landscape** orientation radio button. This option conserves paper.

8. Click the **Layout View** tab in the Properties dialog.  
   The **Layout View** information displays.
The **Layout View** tab shows that the width is 36”, and the height is 26”. The 36” dimension runs across the 36” width of the roll of paper.

9. Click the **Options** tab in the Properties dialog.
   The options display. In this tab you make color and paper selections.

10. In the **Options** tab, click the checkbox for **Manual color**.
   You are going to come back to the **Color control** setting in a moment.

11. Click the **Paper type** dropdown list, and select the type of paper.
The **Quality** setting controls the dots per inch (dpi) that is used to plot the map. There are different quality designations used by different printer drivers. Some common HP quality designations are:

- Fast (draft) (300 dpi)
- Normal (final) (300 dpi)
- Best (enhanced) (600 dpi)
- Economy (300 dpi)
- Productivity (300 dpi)
- Photo (600 dpi)

12. Click on the **Advanced** tab in the Properties dialog. The advanced options display in the Properties dialog.
13. In the **Process document** section of the **Advanced** tab, click the **In computer** radio button.

You need to select the **In computer** option in order to successfully print the color calibration pages which follow.

A Hint dialog opens that warns of slower printing. You are going to process the document in the computer memory when you do not pre-rasterize anyway.

14. Click **OK** in the Hint dialog.

15. Click the **Inked Area** checkbox.

Your **Advanced** tab should now look like the following:
Color control

1. Click the Options tab in the Properties dialog.

2. Click on the Color control button in the Options tab.
   The Color Control dialog opens.

3. In the Printed color control section of the Color Control dialog, click on the User defined color correction radio button.

4. Click on the Start Color Correction Wizard button.
   The Start Color Correction Wizard dialog opens.
5. Click the **Use the current document in your application** radio button.

   The next Start Color Correction Wizard dialog opens. It provides information about using the current document as the basis for the Color Correction Wizard.

6. Click **OK** in the Start Color Correction Wizard dialog.

   A Job Status dialog opens to show the progress of the document capture.

7. Click **OK** in the Color Control dialog and the Map Composition dialog.

8. Depending on your preference settings, you may need to click **OK** in the Job Status dialog to close it.

   The Color Correction Wizard welcome dialog opens.
9. Click **Next** in the Color Correction Wizard dialog.
   The next Color Correction Wizard dialog suggests a series of steps.

10. Click **Next** in the Color Correction Wizard dialog.

11. Click **Next** when the No transformation message is displayed above the document preview.
    The Brightness is adjusted in this step.
The next dialog advises you to prepare the printer. Next, the sample pictures are going to be printed.

12. Click **Next** to print the sample images.

13. Once you get the sample images from the printer, compare the sample image printout to the map on your screen.

14. In the **Picture Selected** section, type the number of the image that best represents the brightness of the map. In this example, **9** is the best.

15. Click **Back** twice to define the contrast setting.
The Color Correction Wizard dialog that follows allows you to set Contrast:

16. Click on the **Contrast** radio button.

17. Click **Next** when the No transformation message is displayed above the document preview.

18. Click **Next** to print the sample images.

19. In the **Picture Selected** section, type the number of the image that best represents the brightness of the map. In this case, **8** is best.

20. Click **Back** twice to define the **Color Balance** setting.

21. Click **Back** again.
22. Click on the **Color Balance** radio button.

23. Click **Next** when the No transformation message is displayed above the document preview.

24. Click **Next** to print the sample images.

25. In the **Picture Selected** section, type the number of the image that best represents the brightness of the map. In this case, 6 is best.

26. Click **Next** in the Color Correction Wizard dialog.

   Now, you have defined all three elements of the Color Correction Wizard: **Brightness**, **Contrast**, and **Color Balance**.
27. Click on **Finish** in the Color Correction Wizard.  
A dialog opens advising you that the color calibration was a success.

28. Click on **OK** in the Color Calibration Successful dialog.  
You are returned to the Properties dialog. If you have the **User Defined Color Correction** selected, it uses your color calibration.

29. Click the **Advanced** tab in the Properties dialog.

30. Click **OK** in the Properties dialog.

Return to the Print Map Composition Dialog

1. Click the **Page Setup** tab in the Print Map Composition dialog.
Your Print Map Composition dialog Page Setup tab should look like this:

2. Click the **Options** tab of the Print Map Composition dialog. The **Options** tab looks like this:

3. Click the **Preview** tab of the Print Map Composition dialog. Finally, your **Preview** tab should look like this:
4. Click OK to print your map.

**Pre-Rasterize**

Another scenario involves the **Pre-Rasterize** option. If you want to print large maps or print to higher resolution print devices, it is probably necessary to utilize the **Pre-Rasterize** option in ERDAS IMAGINE in conjunction with an HPRTL driver. There are similar languages that can be utilized with plotters sold by other printer manufacturers.

This map is large. It is 52” x 68”. It is printed at 600 dpi, and would easily exceed the system limits for successful printing. This map cannot print without pre-rasterization unless the Printer Data Transfer Compression preference is set to high. Even then, the raster data that is printed appears highly degraded as no higher than a compression factor of low or 2 can be effectively used with this data. Consequently, the **Pre-Rasterize** option is used in order to print successfully.
The 52” height of the map corresponds with the 54” width of the paper for the HP 3500. There are effectively 31200 pixels, or dots, available for plotting at 600 dpi. The image in the map frame is 37000 pixels high. This map would be best processed with the **Printer Data Transfer Compression** preference set to **none**, but that would also quadruple the amount of data that is sent to the plotter. So, you are going to use the default **Printer Data Transfer Compression** preference **low**. This generally provides acceptable results.

**Preparation**

ERDAS IMAGINE must be running.

You must have a map composition displayed.

*NOTE: The map composition displayed in this scenario is not supplied with the examples data.*

1. In the Map Composer dialog, click the Print icon.

   This brings up the Print Map Composition dialog. The Print Map Composition dialog opens on the **Printer** tab. In this tab, you can select a printer you have configured.

   *For information about how to configure a printer, see the most recent ERDAS IMAGINE Installation Guide.*

2. In the Print Map Composition dialog, select the printer from the **Print Destination** dropdown list.

   ![Select the printer from the dropdown list](image)

   Once you choose your printer, the **Rasterize before printing** option displays.
3. Click the **Rasterize before printing** checkbox.

4. Click on the **Change printer configuration** button.
   
   The Properties dialog opens. It has the name of the printer you selected as the **Print Destination**.

5. In the **Application page size** section of the Page Size tab, set the paper size to 54” x 72”.

6. Click on the **Layout View** tab of the Properties dialog.
7. Look at the **Layout View** to verify the parameters.

8. Click on the **Options** tab of the Properties dialog. The Options display.

9. Set the **Paper type** and **Quality**. The **Quality** should be set to **Photo** or **Best**, which is 600 dpi if the highest quality is desired.

10. Click on the **Manual color** radio button in the **Options** tab.
11. Click on the **Color control** button to check the Color Control settings.

  The Color Control dialog opens.

  ![](image1)

  Select the User defined color correction radio button

12. Set the **Printed color control** to **User defined color correction**.

   This should still be set to the same values used in the previous exercise, "No Pre-Rasterize". If you did not perform the previous exercise, the procedure for setting the User defined color correction is fully described there, in "Color control".

13. Click on the **Advanced** tab.

14. Click the **In Printer** radio button.

   In the previous exercise, the **In Computer** radio button was set so that printing could be done using the no pre-rasterize method in ERDAS IMAGINE.

15. Click **OK** in the **Advanced** tab.
16. Verify the parameters on the **Page Setup** tab.

17. Click the **Options** tab.

18. Verify the parameters on the **Options** tab.

19. Click on the **Preview** tab.
20. Examine the Print Preview.

21. Click **OK** in the Print Map Composition dialog to print.
Adding Fonts to Annotation

Introduction

This section describes how to add new fonts to ERDAS IMAGINE annotation.

Create an .fdb File

To add True Type system fonts to the ERDAS IMAGINE annotation package, you must add the new fonts to a font data base (.fdb) file in any of the directories specified in the ERDAS_FONT_PATH, which is, by default, the <IMAGINE_HOME>/etc/fonts directory where ERDAS IMAGINE is installed on your system.

You can create a new file or edit an existing file. You may use <IMAGINE_HOME>/etc/fonts/fontlist.fdb as an example, but be aware that the contents of the fields may look different for the OTL fonts that are distributed with Leica Geosystems software, and that your file should only have entries for your fonts.

If you create a new file, you can give it any name as long as it is in one of the directories mentioned above. User-defined directories may be used by adding them to the ERDAS_FONT_PATH environment variable in the Environment tab of the ERDAS IMAGINE Properties dialog. Note that a file named “a.fdb” in the current directory overrides a file named “a.fdb” in the directory from which you started ERDAS IMAGINE, which in turn overrides a file named “a.fdb” in the etc/fonts directory.

The first line of the .fdb file must be .

You must have a seven-field entry in your .fdb file for every font you want the annotation package to know about. All of the name and string fields in the entry should be in quotes.

The following chart lists these fields and the information they specify.

<table>
<thead>
<tr>
<th>Field Number</th>
<th>Field Name</th>
<th>Font Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>One</td>
<td>Font Name</td>
<td>Use the Font File Name below (without variations) or use another name of your choice. This is the name you see in the scrolling list of available fonts in the Text Style Chooser, plus any special weight and/or slant attributes.²</td>
</tr>
<tr>
<td>Two</td>
<td>Font File Name</td>
<td>This field is the Font Name as shown in Fonts Control Panel.</td>
</tr>
</tbody>
</table>
Table 1: Font Fields (Continued)

<table>
<thead>
<tr>
<th>Field Number</th>
<th>Field Name</th>
<th>Font Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Three</td>
<td>ASCII PostScript File Name</td>
<td>This is a printer-downloadable file that goes with the selected font. It is the font file that is included in the EPS file that is created when you output your Map Composition to an EPS file. When you transfer the EPS file to another application (e.g., Microsoft Word) and print the document, this file is actually downloaded to your PostScript printer. If you do not specify a PostScript file in this field, you are not able to create a usable file.</td>
</tr>
<tr>
<td>Four</td>
<td>Windows Font Name</td>
<td>When a font is selected, the Windows font specified here is used in the annotation text entry fields, where text is entered or displayed. If you just want the standard ERDAS IMAGINE text font to be used, use the word “default” If you want the font that you are adding to be displayed in the text entry fields, use the same name here that you used for the font file name (Field Number Two).</td>
</tr>
<tr>
<td>Five</td>
<td>Font Language Flag</td>
<td>This is the only field that must not be in quotes. It is the flag that indicates whether the language for which this font is used is written left-to-right or right-to-left. If the language is written left-to-right, use LEFT_TO_RIGHT for this field. If the language is written right-to-left, use RIGHT_TO_LEFT for this field.</td>
</tr>
<tr>
<td>Six</td>
<td>Sample String</td>
<td>This is the string that you want to use for the text style sample in the Text Style Chooser. For English, something like “AaBbCc” or Abc123” is commonly used, but you may wish to use some other string, particularly for other alphabets.</td>
</tr>
<tr>
<td>Seven</td>
<td>Font Server Name</td>
<td>This is the name of the font server to be used to read the font. Use “MSW” for this field.</td>
</tr>
</tbody>
</table>

1 This information is not an actual description of the fields in the .fdb, files, but instructions on where to find the information for the True Type fonts you are adding.

2 Weight attributes that are recognized in the Text Style Chooser are “Extra-Bold,” “SemiBold,” “Bold,” “Heavy,” “Medium,” “Light” and “Thin,” the only slant attribute that is recognized is “Italic.”

3 This file must be in the $IMAGINE_HOME/etc/fonts directory. If you do not have a
downloadable ASCII PostScript font file for this font, use the word “none.”

Example .fdb Entries

Below is an example of an entry in an .fdb file for a font that uses the standard ERDAS IMAGINE font in the text entry fields.

Arial Thin
Arial Narrow
arial.ps
"default"
LEFT_TO_RIGHT
“AaBbCc”
“MSW”

⚠️ The fields are printed on separate lines for space reasons. They should all be on one line in the .fdb file.

Below is an example of an entry for a font for which there is no downloadable PostScript file. This example uses the same font for the text entry fields as for the annotation itself.

“Suu kyi”
“Suu kyi”
“none”
“Suu kyi”
LEFT_TO_RIGHT
“AaBbCc”
“MSW”

See $IMAGINE_HOME/etc/fonts/fontlist.fdb for other examples.
**Font to Symbol Utility**

ERDAS IMAGINE contains a utility for converting font sets into Symbol Libraries for use in Annotation layers. This utility is accessed by clicking **Utilities -> Font to Symbol** from the menu bar on the ERDAS IMAGINE icon panel.

1. To create a new symbol library, click on a font in the Font list. The CellArray displays the characters and Symbol Names.

2. Select a row by left-clicking on the Row number.

3. Rename the Symbol by left clicking on the symbol name. In this case, “Baskerville 38” has already been changed to “ampersand.”

4. If you change the symbol name, you will need to rename the Symbol Library Category by left clicking in the Symbol Library Category field and typing in a new name.

5. Click Apply.

The Symbol Library has been created. It references the font set on your system and is ready to use in Annotation layers.

---

*This utility references the fonts listed on your computer. If you remove that font, the symbol library will be lost.*

*If you want to transfer the symbol library, you must also include the referenced font set.*
Configuring IMAGINE VirtualGIS

Stereo Configuration for Windows Systems

Only Stereo-In-A-Window is supported for Windows 2000 and Windows XP Professional. A stereo graphics emitter, an emitter cable, liquid crystal glasses, and a stereo-capable graphics card are required to use the Stereo-In-A-Window option.

Most stereo-capable graphics cards provide a control panel for enabling and disabling stereo display (see your graphics card’s instructions). The card must be stereo-enabled before starting IMAGINE VirtualGIS.

Contact StereoGraphics (http://www.StereoGraphics.com) for the specific cable needed to work with your system and graphics card.

ERDAS IMAGINE Preference Settings

Several ERDAS IMAGINE preferences can be modified to improve the performance of IMAGINE VirtualGIS. These changes may affect other applications running within the ERDAS IMAGINE environment.

ERDAS IMAGINE Image Files (Native)

The Memory Map File Size Limit and Memory Map Segment Height preferences should both be set to 0.000. This disables memory mapping. Some Virtual Worlds built in the Virtual World Editor could be greater than the defaults displayed.
Index

Symbols
.fdb entries 93
.fdb file
create 91

A
ArcObjects 21

C
Color control 76
Color Correction Wizard 76
Configuring IMAGINE VirtualGIS for Windows 95

D
Disk Space 3

E
ERDAS software security 5

G
Geodatabase Support 21

I
In computer 66
Install Manager 35
Installation 6

L
License Server
  customizing 62

M
Memory settings 66

N
No Pre-rasterize 68

P
Print scaling factor preference 67
Printing
  data lost 66
  nothing prints 66
  out of memory 66
  preferences 67
  Pre-rasterize 84
  scenarios 68
  spool RAW data 67
  troubleshooting 66

R
Rasterize before printing 66

S
Stereo configuration for Windows systems 95
Stereo-In-A-Window 95
Strip height preference 67
SysID information 39
System requirements 3

T
The ERDAS IMAGINE CD-ROM 7

U
uninstalling 35